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SAMSUNG CJX-1000 All-in-One Printer

Your SAMSUNG All-in-One Printer combines ease-of-use and affordable inks to provide  
high-quality pictures and documents.

Resources

Support is available! Go to www.samsung.com/printer for:

 ■ answers to questions
 ■ software upgrades
 ■ and more!

If you prefer, you can chat online, send us an e-mail, or call for technical support.  
Go to www.samsung.com/printer.

www.samsung.com/printer
www.samsung.com/printer
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Contact SAMSUNG worldwide
If you have any comments or questions regarding Samsung products, contact the 
Samsung customer care center.

Country / Region Customer Care Center Web Site

FRANCE 01 48 63 00 00 www.samsung.com/printer

GERMANY 01805 - SAMSUNG  
(726-7864 € 0,14/min)

www.samsung.com/printer

ITALY 800-SAMSUNG (726-7864) www.samsung.com/printer

www.samsung.com/printer
www.samsung.com/printer
www.samsung.com/printer
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Components

Printer Overview

This printer lets you print, copy, and scan pictures and documents.

1

1  Left paper-edge guide 

2  Paper guard 

3  Paper input tray

4  Right paper-edge guide

5 Paper output tray

6 Output tray extender
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8

7

10

9

7  Scanner lid 

8  Scanner glass 

9 Control panel

10 Memory card slot
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1314

11

210

12

11  Access door

12 Printhead with ink cartridges installed 

13  USB port

14  Power cord connection port
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Control panel
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Feature Description

1 LCD Displays pictures, messages, and menus

2 Cancel button Stops the current operation and returns to the menu

3 Menu button Displays the main menu

4 Navigation buttons Used to navigate menus, scroll through pictures

5 Start button Begins copying, scanning, printing, maintenance tasks, 
and file transfer

6 OK button Selects a menu item or allows you to continue with the 
current operation

7 Back button Displays the higher level screen in the menu structure

8 Power button Turns the printer on or off
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Print Manager Software
SAMSUNG Print Manager Software is installed with your SAMSUNG All-in-One Printer 
Software unless you chose otherwise during installation. The Print Manager icon will 
appear on your desktop.

On a computer with WINDOWS Operating System (OS), you can use Print Manager  
Software to browse and edit pictures, print, copy, scan, order supplies, and configure your 
all-in-one printer from your computer.

On a computer with MAC OS, you can use Print Manager Software to order supplies and 
configure your printer from your computer.

Configuring printer settings
To set or change basic printer settings:

1 Press Menu.
2 Press  to select Printer Settings, then press OK.
3 Press  to select one of the following settings:

 ■ Date and Time
 – Press OK, then press  to select Year, Month, Day, Hour, or Minute.
 – Press  or  to change the values; press OK when you are done making 
changes.

 – Press Back to go back to the Printer Settings menu.
 ■ Time to Low Power
To conserve energy, your printer will enter a low power (sleep) mode after being 
idle for a default delay time of 1 hour. You can increase the delay time to low 
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power (in 0.5 hour increments) up to 4 hours. Increasing the delay time may 
result in reduced energy savings.

 – Press  to change the time to energy-saving sleep mode (select from 1 to 4 
hours in 0.5 hour increments).

 ■ Tagged Images Printing (see Printing tagged pictures, page 26)
 – Press  to select Off or On.

 ■ Language
 – Press OK, press  to select a language, then press OK.

 ■ Country/Region
 – Press OK, press  to select a country or region, then press OK.

 ■ Reset All Settings (see Resetting factory defaults, page 61)
NOTE: Resetting factory defaults does not change the date and time, language, 

country/region, or network settings.

 ■ Printer Info
 – Press OK to view the Firmware Version number; press OK when you are done.

4  Press Back to return to the Main Menu.

Paper
For the best photo printing results, use KODAK Photo Papers, which are optimized to 
work with SAMSUNG All-in-One Printers.

For the best document printing results, use KODAK Document Papers or a paper with the 
COLORLOK Technology logo on the package. Use only paper that is designed for inkjet 
printers.
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Paper types
You can use:

 ■ Plain paper — 16 to 24 lb / 60 to 90 gsm
 ■ Photo paper — up to 12 mils
 ■ Card stock — 110 lb / 200 gsm, max
 ■ Envelopes — most standard types
 ■ Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
 ■ Iron-on transfers — all inkjet varieties on 8.5 x 11-in. or A4 sheets

Paper sizes

Minimum size Maximum size

English units 4 x 6 in. 8.5 x 14 in.

Metric units 10 x 15 cm 22 x 36 cm
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Loading paper
1 Lift the input tray.

2 Open the output tray, then pull out the extender until it is fully extended.
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Loading plain paper

The input tray capacity is 100 sheets of plain paper.

To load plain paper:

1 Fan and stack the paper.
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2 Make sure the left and right paper-edge guides are in the far left and far right  
positions, then insert the paper into the input tray.
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Loading photo paper

The input tray capacity is 20 sheets of photo paper.

To load photo paper (smaller than 8.5 x 11 in.):

1 Remove any paper from the tray.
2 Insert the paper (short side first) into the center of the input tray with the logo side 

toward the tray and the glossy side toward you.

IMPORTANT: If the photo paper is loaded the wrong way, print quality will be affected.

3 Move the paper-edge guides until they touch the paper.
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Basic Functions

Printing

Printing documents
To print a document from your computer:

1 Open the document.
2 Select File > Print.
3 In the Print window, select your SAMSUNG Printer.
4 Choose the pages to print, number of copies, etc, then click OK (on a computer with 

WINDOWS OS) or Print (on a computer with MAC OS).

2
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Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts  
(see Paper sizes, page 8) by rotating the paper manually as described below.

IMPORTANT: Two-sided printing can only be done on media that can absorb ink on 
both sides, such as plain paper or two-sided photo paper. Two-sided 
printing will not work on bar-coded photo paper (the bar code is on the 
back side).

Printing two-sided documents from a computer with WINDOWS OS

To print two-sided documents from a computer with WINDOWS OS:

1 Load paper into the paper input tray.
2 Open the document you want to print, then select File > Print.
3 In the Print dialog box, make sure that SAMSUNG CJX-1000 Series AiO is selected, 

then click Properties.
4 Select the Layout tab.
5 In the Two-sided printing field, select Manual (Instructions provided), then click OK.
6 Click OK.
7 When a message appears on your computer or printer LCD, remove the printed 

pages from the output tray, and follow the instructions on the computer or LCD.
8 Turn the printed pages over, and place into the input tray (top edge down and 

printed side away from you).
9 Press Start on the printer.
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Printing two-sided documents from a computer with MAC OS

To print two-sided documents from a computer with MAC OS:

1 Load paper into the paper tray.
2 Open the document you want to print, then select File > Print.
3 In the Print dialog box, make sure that SAMSUNG CJX-1000 is selected.
4 In the Copies & Pages drop-down list, select Paper Handling.
5 In the Pages to Print drop-down list, select Odd Only.
6 In the Page Order drop-down list, select Reverse.
7 Click Print.
8 When the odd pages have finished printing, remove them from the output tray.
9 Turn the printed pages over, and place into the input tray (top edge down and 

printed side away from you).
10 Select File > Print.
11 In the Copies & Pages drop-down list, select Paper Handling.
12 In the Pages to Print drop-down list, select Even Only.
13 In the Page Order drop-down list, select Normal.
14 Click Print.
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Printing pictures
You can print pictures with your all-in-one printer from a memory card inserted into the 
memory card slot.

You can also print pictures using Print Manager Software from your computer with  
WINDOWS OS. Print Manager Software lets you edit and enhance your pictures quickly. 
Open Print Manager Software, select Print Pictures, then follow the on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from any 
picture-editing or photo-management software.

Printing pictures from a memory card

Your printer accepts the following memory cards:

 ■ SD Card
 ■ SDHC Card
 ■ MMC Card
 ■ MEMORY STICK
 ■ Variations of the memory cards above that require an adapter (for example, 

MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and 
remove the adapter and the memory card as a unit; do not remove the 
memory card while leaving the adapter in the printer.
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To print a picture from a memory card:

1 Insert the memory card into the memory card slot.

memory card slot

2 Use  or  to browse to the picture you want to print, then press OK.
3 Repeat step 2 for each same-size picture you want to select for printing.
4 Select a print size.

a Press Back.
b Press  to select Print Size.
c Press  to navigate to the size picture you want to print.

5 Press Start to begin printing.
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Viewing pictures on a memory card

When you insert a memory card into the memory card slot on your printer, the pictures on 
the card appear on the LCD. Press  or  to scroll through the pictures. 

If the printer is idle for more than two minutes, the LCD will revert to the status display. 
To view the pictures again, press any button, then press  or  .

Finding pictures on a memory card

Your printer can help you locate pictures on a memory card by the date the picture was 
taken or last saved.

To locate pictures:

1 Insert the memory card into the memory card slot.
2 Press Menu.
3 Press  to select View / Print Photos, then press OK.
4 Press  to select Find Photos, then press OK.
5 In the View by Date menu, press to select Year, Month, or Day; press  or  to select 

the specific year, month, or day. 
The number of photos found for the date you specified appears under the menu 
name. To view these pictures, press OK.

6 To view these pictures, press OK.
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Using default settings to print a picture

To print a picture from a memory card using the factory default settings:

1 Load photo paper (short side first) into the center of the input tray with the glossy 
side toward you (see Loading photo paper, page 12), and move the paper-edge 
guides until they touch the paper.
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2 Insert the memory card into the memory card slot.

memory card slot

3 Press  or  to display the picture you want to print.
4 Press Start to begin printing. 

The printer prints one 4 x 6 in. / 10 x 15 cm picture.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.
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Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of pictures, or 
you can change the settings and save them as the default.

To print a picture or pictures using settings other than the default settings:

1 Load photo paper with the glossy side toward you (see Loading photo paper, page 12), 
and move the paper-edge guides until they touch the paper.

2 Insert the memory card into the memory card slot. A picture appears on the LCD.

memory card slot

3 Press  or  to select the picture you want to print, then press OK.
4 Repeat step 3 for each picture you want to print.
5 Press Back for Print Photos Options.
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6 Press  to select an option (see table below), then press  or  to change the 
setting.

Print Photos Option Settings Description

View Photos -- Scroll through the pictures on the 
memory card; press OK to select 
the picture for printing; press Back 
to display the Print Photos Options 
menu.

Find Photos -- Press OK, then select a year, month, 
and/or day to view photos by date 
that they were taken; press OK to 
view the photo(s); press Back to 
display the Print Photos Options 
menu. 

Transfer All to PC -- To transfer all the pictures on the 
memory card to your computer, 
press OK then Start. (Your printer 
and computer must be connected 
with a USB cable.)
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Print Photos Option Settings Description

Rotate This Photo -- Press OK, then press  or  to 
rotate the image on the LCD. (This is 
for viewing purposes only and does 
not affect how the picture prints.) 
Press Back to display the Print 
Photos Options menu.

Quantity 1 (default) to 99 The number of copies that print. 

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Print Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size.
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Print Photos Option Settings Description

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality.

Draft The fastest print speed.

Photo Paper Quality Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Scene Balance On (default)

Off

Adjusts the image brightness to 
correct for underexposure and 
reduces the variation in contrast in 
different areas of the picture.

Add Date to Prints No (default)

Yes

Prints the date of the picture(s) (the 
date the picture was taken or last 
edited) in a corner of the print.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

7 When you have finished changing settings, press Start to begin printing.

IMPORTANT: To prevent loss of data from your memory card, camera, or portable drive, 
do not remove it from the printer while printing.
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Printing panoramic pictures

To print a panoramic picture, load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 paper 
in the main paper tray.

1 Insert the memory card into the memory card slot.

memory card slot

2 Press  or  to select the panoramic picture you want to print, then press OK.
3 Press Back for Print Photos Options.
4 Press  to select Print Size, then press  to select 4 x 12.
5 Press Start.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the 
printer while printing.
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Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for printing. 
This creates a tag that is recognized by the printer. If you choose to print tagged pictures, 
they will be printed according to the default settings on your printer (unless otherwise 
specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine whether your camera supports 
tagged (also “marked” or “DPOF”) functionality.

To print tagged pictures:

1  Load photo paper with the glossy side toward you (see Loading photo paper, page 12), 
and move the paper-edge guides until they touch the paper.

2 Insert the memory card into the memory card slot.

memory card slot

3 When the “Print tagged images?” message appears, press Start.
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Copying
You can copy documents and pictures with your all-in-one printer. The printer produces 
high–quality color or black-and-white copies on a variety of paper types  
(see Paper types, page 8).

Copying a document
You can copy a document using the default settings, or you can adjust the quantity, size, 
quality, and brightness of your copies.

Using the default settings to copy a document

The default settings are either the factory default settings (see Resetting factory defaults, 
page 61), or defaults that you have set on the printer (see Save as Defaults, page 24).

To copy a document using the current default settings:

1 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.
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2 Close the lid.
3 Press Menu.
4 Press Start to begin copying

Adjusting the settings and copying a document

To copy a document using settings other than the default settings:

1 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 With Copy Document selected, press OK.
5 Press  to select an option, then press  or  to change the setting.
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Copy Document 
Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).

Copy Size Same Size 
(default)

The copy is the same size as the 
original.

Fit to Page The printer detects the size of the 
original on the scanner glass and 
the size of the paper in the paper 
tray, and automatically reduces or 
enlarges the original so that the 
copy fits on the paper.

20% to 500% Reduces down to 20% or enlarges 
up to 500% of the original size.
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Copy Document 
Option Settings Description

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the 
lowest quality.

Photo Paper Quality Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Brightness Normal, -3 to 
+3 (Normal is 
default)

Lightens or darkens the copy. 
Normal is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

6 Press Start to begin copying.
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Changing the number of copies of a document

To change the number of copies:

1 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 With Copy Document selected, press  or  to select a number.
5 Press Start to begin copying.

Enlarging or reducing a document

To enlarge or reduce the size of the copy:

1 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 With Copy Document selected, press OK.
5 Press to select Copy Size.
6 Press  or  to select an enlargement or reduction.
7 Press Start to begin copying.
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Darkening or lightening a copy

To darken or lighten the copy:

1 Lift the scanner lid, and place the document face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 With Copy Document selected, press OK.
5 Press  to select Brightness.
6 Press  to select a number below zero for a darker copy, or press  to select a 

number above zero for a lighter copy.
7 Press Start to begin copying.

Copying a photograph
You can copy a photograph using the default settings, or you can adjust the quantity, 
size, quality, and brightness of your copies.

Using the default settings to copy a photograph

The default settings are either the factory default settings (see Resetting factory defaults, 
page 61), or defaults that you have set on the printer (see Save as Defaults, page 24).

To copy a photograph using the current default settings:

1 Load photo paper into the printer (see Loading photo paper, page 12).
2 Lift the scanner lid, and place the photograph face down in the right-front corner of 

the scanner glass.
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3 Close the lid.
4 Press Menu.
5 Press  to select Copy Photo.
6 Press Start to begin copying.

Adjusting the settings and copying a photograph

To copy a photograph using settings other than the default settings:

1 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 Press  to select Copy Photo, then press OK.
5 Press  to select an option, then press  or  to change the setting.

Copy Photo Option Settings Description

Quantity 1 (default) to 99 The number of copies that print.

Color Color (default) Prints full color.

Black & White Prints black and white (grayscale).
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Copy Photo Option Settings Description

Copy Size 2 x 3

3.5 x 5

4 x 6 (default)

4 x 7

4 x 8

5 x 7

4 x 12

8 x 10

8.5 x 11 or A4

The printer enlarges or reduces the 
original to make it the copy size you 
select.

If the selected copy size is smaller 
than the paper in the paper tray, the 
printer automatically arranges the 
pictures to best fit the paper size.

Plain Paper Quality Normal (default) Good quality output; prints faster 
than Best.

Best The highest quality, but the slowest 
print speed; eliminates the banding 
effect that sometimes occurs when 
printing Draft or Normal.

Draft The fastest print speed, but the 
lowest quality.
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Copy Photo Option Settings Description

Photo Paper Qualitya Auto. (default) The printer detects photo paper in 
the paper tray and sets Best quality 
automatically.

Brightness Normal (default)

-3 to +3

Lightens or darkens the copy. 
Normal is no change from the 
original; -3 is the darkest; +3 is the 
lightest.

Preview No (default) 

Yes

To see a preview of the photograph 
on the LCD, select Yes.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

a.  For photo paper quality copies, load photo paper into the printer 
(see Loading photo paper, page 12)

6 Press Start to begin copying.
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Changing the number of copies of a photograph

To change the number of copies:

1 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 Press  to select Copy Photo, then press OK.
5 Make sure Quantity is selected.
6 Press  or  to select a number.
7 Press Start to begin copying.

Enlarging or reducing a photograph

To enlarge or reduce the size of the copy:

1 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 Press  to select Copy Photo, then press OK.
5 Press  to select Copy Size.
6 Press  or  to select the copy size.
7 Press Start to begin copying.
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Darkening or lightening a photograph

To darken or lighten the copy:

1 Lift the scanner lid, and place the photograph face down in the right-front corner of 
the scanner glass.

2 Close the lid.
3 Press Menu.
4 Press  to select Copy Photo, then press OK.
5 Press  to select Brightness.
6 Press  to select a number below zero for a darker copy, or press  to select a 

number above zero for a lighter copy.
7 Press Start to begin copying.
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Scanning
Scanning digitizes documents and pictures, and sends the digital files to your computer.

When you scan, the digital file can:

 ■ Open in Print Manager Software (when connected to a computer with WINDOWS OS)
 ■ Open in a third-party scanner software
 ■ Be saved in a format and location that you determine  

(see Changing the scan settings for scanning from the control panel, page 38).
There are two ways to scan: From the control panel on the printer, or from a software 
program on the computer. Scanning from a software program on the computer (such as 
Print Manager Software) is recommended because it gives you more options.

Before you begin scanning
Make sure that the printer is connected to a computer using a USB cable. If you plan to 
scan directly from the printer control panel, change the scan settings as described below.

Changing the scan settings for scanning from the control panel

Adjust the scan settings that the printer uses before you scan from the printer control 
panel.

1 Open the Printer Tools window.
 ■ On a computer with WINDOWS OS, select Start > All Programs > Samsung > 

Samsung AiO Printer Tools.
 ■ On a computer with MAC OS, open Print Manager Software, then select the 

Tools tab.
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2 Under the Tools heading, select Printer Scan Settings.
3 Adjust settings for scanning documents and pictures:

a To select a program that scanned images or documents will appear in when you 
scan from the printer control panel:
(1) Select the General tab.
(2) Under the Program List heading, click  next to the currently selected 

program.
(3) From the drop-down list, select the program in which you want the scanned 

files to open.
b To adjust settings for scanning documents, select the Document tab, then select 

an option for each setting:

Setting Options

Scan As Black and white

Color

Grayscale

File format .pdf

.rtf  (available only when connected to a computer 
with WINDOWS OS)

.tif

.jpg

.bmp  (available only when connected to a 
computer with MAC OS)
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Setting Options

Resolution (dpi) 75

150

200

300

File Save Prompt for File Name and Location

Automatically Save - specify:

 ■ Base name; by default, scanned files are 
names “scan1”, “scan2”, and so on.

 ■ Location (folder) where the scanned files will 
be saved

c To adjust settings for scanning pictures, select the Picture tab, then select an 
option for each setting:

Setting Options

Scan As Color

Black and white

File format .jpg

.bmp

.tif
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Setting Options

Resolution (dpi) 75

150

200

300

600

Quality When connected to a computer with WINDOWS OS:

 ■ Best for E-mail
 ■ Normal
 ■ High
 ■ Maximum

When connected to a computer with MAC OS,  
a slider bar with:

 ■ Least
 ■ Medium
 ■ Best

Automatically Detect 
Pictures (when connected 
to a computer with 
WINDOWS OS) or Auto 
Crop (when connected to 
a computer with MAC OS)

When selected, multiple pictures placed on the 
scanner glass are saved as separate files.
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Basic Functions

Setting Options

File Save Prompt for File Name and Location

Automatically Save - specify:

 ■ Base name; by default, scanned files are 
names “scan1”, “scan2”, and so on.

 ■ Location (folder) where the scanned files will 
be saved

NOTE: Before you save a scanned file, you will be able to preview it in Print Manager 
Software, crop and sharpen the image, and adjust color, if desired. On a computer 
with WINDOWS OS, see the Print Manager Software Help (? icon) for instructions.

4 When you are finished making selections, click OK on the bottom right of the Printer 
Scan Settings window.

5 Close the Printer Tools window.
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Scanning from the computer
To scan a document or a picture on a computer:

1 Lift the scanner lid, and place the document or picture face down on the glass.
2 Close the scanner lid.
3 Open Print Manager Software.

 ■ On a computer with WINDOWS OS, double-click Scan Documents and 
Pictures, then follow the on-screen instructions.

 ■ On a computer with MAC OS and Print Manager Software, select the Tools tab, 
click Scan Application, then follow the on-screen instructions.

NOTE: If you are not using Print Manager Software, open a program that allows you to 
scan, then follow the instructions.

Scanning multiple pictures simultaneously

Using Print Manager Software, you can scan multiple pictures simultaneously and save 
them as separate files.

When scanning multiple pictures, leave space between the pictures so that the printer 
can detect the separate pictures. Any pictures that overlap are interpreted as a single 
picture.
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Scanning multiple pictures when connected to a computer with WINDOWS OS

To scan multiple pictures simultaneously, and save them as separate files:

1 Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures.

2 Close the lid.
3 Open Print Manager Software, then double-click Scan Documents and Pictures.
4 Make sure that Picture is selected and Collage - Combine all pictures is cleared, 

then follow the on-screen instructions.
NOTE: Click the Help icon for additional instructions.

Scanning multiple pictures when connected to a computer with MAC OS

To scan multiple pictures simultaneously, and save them as separate files:

1 Lift the scanner lid, and place the pictures face down on the glass, leaving space 
between the pictures.

2 Close the lid.
3 Open Print Manager Software, then select your printer.
4 Select the Tools tab.
5 Click Scan Application.
6 Select Color Picture or Black and White Picture.
7 Select Automatically detect multiple pictures, if it is not selected.
8 Click Preview or Scan All, then follow the on-screen instructions.
NOTE: Click the Help icon for additional instructions.
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Scanning from the control panel
To scan a document or a picture from the control panel:

1 Lift the scanner lid, and place the original document or picture face down in the 
right-front corner of the scanner glass.

2 Close the lid.
3 Press Menu.
4 Press  to select Scan, then press OK. 

The Scan Options menu appears on the LCD.
5 Press  to select an option, then press  or  to change the setting.
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Scan Option Settings Description

Scan To USB computer 
(default)

The scanned file is sent to the 
USB-connected computer.

Name of 
computer (only 
if a computer 
is connected 
by wireless 
network)

The scanned file is sent to the 
computer on the wireless or 
Ethernet network.

Memory Card The scanned file is sent to the 
memory card in the memory card 
slot

Scan What Document 
(default)

Sets the scan settings for scanning 
a document (see Changing the 
scan settings for scanning from the 
control panel, page 38).

Photo Sets the scan settings for scanning 
a photograph (see Changing the 
scan settings for scanning from the 
control panel, page 38).
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Scan Option Settings Description

Scan Dest. (Destination) File (default) Sends the scanned file in the format 
and to the destination on your 
computer that you designate (see 
Changing the scan settings for 
scanning from the control panel, 
page 38).

Application Sends the scanned file to Print 
Manager Software.

Save as Defaults No / Yes To save the settings as the new 
default, press OK. With Yes 
selected, press OK.

6 Press Start to make a scan. 
The scanned file appears at the destination you specified.

Ordering supplies
You can order ink cartridges online.

To order supplies, make sure that your computer is connected to the Internet, then:

1 Open Print Manager Software.
2 Select Order Supplies.
3 Select the item(s) you want to buy, then follow the on-screen instructions.
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Maintaining Your Printer

Your printer requires little maintenance. However, Samsung recommends cleaning the 
scanner glass and lid regularly to remove dust and fingerprints, which affect the quality 
and accuracy of scanning.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. If 
you use a power strip, don’t turn off the power strip. (The printer does not need to be 
turned on but should be plugged in.)

For optimal performance, keep the printer connected to a computer that is powered on 
and has the SAMSUNG Print Manager Software installed, or keep the printer powered on 
and connected to the Internet through a wireless network.

Keep the printhead and ink cartridges in the printer at all times to help prevent damage 
to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, go to 
the Electronics Industry Alliance at www.eia.org.

3

www.eia.org
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Maintaining Your Printer

General care and cleaning
 CAUTION:  

Always disconnect the power to the printer before cleaning it. Do not use harsh 
or abrasive cleaners on any part of the printer.

 ■ To clean the printer, wipe the outside with a clean, dry cloth.
 ■ Keep the surrounding area vacuumed and litter-free.
 ■ Protect the printer from tobacco smoke, dust, and liquid spills.
 ■ Do not place objects on the printer.
 ■ Keep the input tray free of dust, dirt, and other foreign objects.
 ■ Keep the printer supplies away from direct sunlight and out of high-temperature 

environments.
 ■ Do not allow chemicals to come into contact with the printer.

Cleaning the scanner glass and document backing
The scanner glass can get smudged and minor debris can accumulate on the white 
document backing under the scanner lid. Periodically clean the scanner glass and 
document backing.

 CAUTION: 
Do not use harsh or abrasive cleaners on any part of the printer. 
Do not spray liquid directly on the glass. 
Do not use paper-based wipes on the document backing as they can scratch it.
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Maintaining Your Printer

To clean the scanner glass and document backing under the scanner lid:

1 Turn off the printer and unplug it from the power outlet.
2 Lift the scanner lid.

3 Wipe the glass with a soft cloth or sponge, slightly moistened with a nonabrasive 
glass cleaner.
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Maintaining Your Printer

4 Dry the glass with a lint-free cloth.
5 Gently clean the document backing with a soft cloth or sponge, slightly moistened 

with mild soap and warm water.

6 Dry the document backing with a chamois or lint-free cloth.
NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) alcohol on 

a soft cloth, then wipe thoroughly with a cloth moistened with water to remove 
any residual alcohol.

7 When you finish cleaning, plug in the printer and press the on/off button to power 
on the printer.
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Maintaining Your Printer

Replacing ink cartridges
Your printer uses both black and color ink cartridges. You can check the approximate ink 
levels on the LCD (see Checking ink levels, page 61). When an ink cartridge is out of 
ink, the printer LCD displays a message stating that the black or color ink cartridge needs 
replacing. You can order ink cartridges online. Open Print Manager Software and select 
Order Supplies.

IMPORTANT: Do not use refilled ink cartridges.

To replace an ink cartridge:

1 Make sure your printer is on.
2 Lift the printer access door, and wait for the carriage to move to a position where 

you can access it.

210



54 EN

Maintaining Your Printer

3 The ink cartridges are located in the printhead.

210

Printhead

Color ink cartridge

Black 
ink cartridge

4 Pinch the tab on the ink cartridge.

210
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Maintaining Your Printer

5 Lift the ink cartridge out of the printhead.

6 Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the 
printhead immediately.
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Maintaining Your Printer

7 Remove the protective cap from the cartridge.

8 Insert the ink cartridge into the printhead.

210
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Maintaining Your Printer

9 Press down on the ink cartridge tab until you hear a click.

210

10 Close the printer access door.
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Maintaining Your Printer

Updating the software and printer firmware
Using the latest software and firmware helps ensure optimal performance of your printer.

NOTE: Firmware is the software that runs on your printer.

Although there is a background check for software and firmware updates, you may 
update manually using the following procedure.

Updating if your printer is connected to a computer with WINDOWS OS
To update the software:

1 Make sure that your computer is connected to the Internet.
2 Select Start > All Programs > Samsung > Samsung AiO Printer Tools.
3 Under Printer Resources, click Check for Software Updates to check whether 

software updates are available.
4 If there are updates, click Next and follow the on-screen instructions.
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Maintaining Your Printer

To update the printer firmware:

1 Make sure that your computer is connected to the Internet.
2 Connect the printer to the computer with a USB cable or wirelessly (if not currently 

connected).
3 Select Start > All Programs > Samsung > Samsung AiO Printer Tools.
4 Make sure that Samsung CJX-1000 Series AiO - Connected appears in the lower 

left corner of the Printer Tools window.
NOTE: If Samsung CJX-1000 Series AiO - Connected does not appear in the lower left 

corner, click Select, then click Refresh List and choose your printer from the list; 
click Install Samsung Printer and follow the on-screen instructions.

5 Under Printer Resources, click Check for Printer (Firmware) Updates.
6 If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the 
update. Doing so may cause the printer to become inoperable. If the 
printer is connected wirelessly, make sure you have a stable connection 
when you perform the update.
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Maintaining Your Printer

Updating if your printer is connected to a computer with MAC OS
To update the software:

1 Make sure that your computer is connected to the Internet.
2 Open Print Manager Software.
3 Select the Tools tab.
4 Click Check for Softwate Updates.
5 If there are software updates, follow the on-screen instructions for updating your 

software.
To update the firmware:

1 Make sure that your computer is connected to the Internet.
2 Connect the printer to the computer with a USB cable or wirelessly (if not currently 

connected).
3 Open Print Manager Software.
4 Select the Tools tab.
5 Click Check for Printer (Firmware) Updates.
6 If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the 
update. Doing so may cause the printer to become inoperable.
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Maintaining Your Printer

Monitoring and adjusting printer performance
From the control panel, you can perform tasks to help keep the printer functioning well.

Checking ink levels
To check the ink levels:

1 Press Menu.
2 Press  to select Maintenance, then press OK.
3 With Check Ink Levels selected, press OK. 

The LCD shows approximate levels of ink in the cartridges so you know when it’s 
time to order replacement cartridges.

NOTE: You can order ink cartridges online. Open Print Manager Software and select 
Order Supplies.

Resetting factory defaults
To reset defaults to the factory default settings:

1 Press Menu.
2 Press  to select Printer Settings, then press OK.
3 Press  to select Reset All Settings, then press OK.
4 When you see the message, “This will reset printer settings to factory defaults,” 

press OK.
NOTE: Resetting factory defaults does not change the date and time, language, country/

region, or network settings.
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Maintaining Your Printer

Replacing the printhead
IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace 

the printhead only if you receive a new printhead from Samsung.

To replace the printhead:

1 Make sure your printer is on.
2 Lift the printer access door, and wait for the carriage to move to the access position.

210
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3 Remove both ink cartridges and set them aside.

210

210

4 Unlatch the used printhead by lifting the button in the center of the carriage.
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Maintaining Your Printer

5 Lift the used printhead out of the carriage.

6 Remove the new printhead from its bag.

 CAUTION:  
Do not touch the copper contacts on the pringhead, as doing so may damage the 
pringhead.
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Maintaining Your Printer

7 Remove the plastic protective cap.

Copper contacts

IMPORTANT: Be careful not to scratch or touch the copper contacts while inserting the 
printhead.

8 Place the new printhead into the carriage.
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Maintaining Your Printer

9 Push firmly against the target label of the printhead until you hear a loud snap.

10 Insert the black ink cartridge into the printhead.

210
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11 Press down on the ink cartridge until you hear it click into position.

210

12 Repeat steps 10 - 11 for the color ink cartridge.

210

210

13 Close the printer access door. 
The printer detects the new printhead. Follow the instructions on the LCD to calibrate 
your printer.
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Troubleshooting

Basic troubleshooting
Some problems can be resolved quickly by power cycling the printer: Turn off your printer. 
Wait five seconds. Turn on the printer.

Use the following information to help troubleshoot problems with your printer.

Problem Possible Solutions

Printer does not 
power on

 ■ Make sure you are using the power cord that came with your 
printer.

 ■ Make sure the power cord is connected to the AC adapter, it 
is plugged into an outlet or power strip, and that the LED on 
the AC adapter is lit.

Printer not 
detected

Make sure that:

 ■ your printer is plugged in and turned on.
 ■ your USB cable:

 – is a USB 2.0 high-speed cable.
 – is connected to both your printer and your computer.

 ■ you restart the computer if the USB cable was disconnected 
from the printer then reconnected, or if power to the printer 
was interrupted.

4
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Troubleshooting

Problem Possible Solutions

Carriage jam  ■ Open the printer access door and clear any obstructions.
 ■ Check that the printhead and ink cartridges are installed 
correctly. 
(The printhead and ink cartridges are installed correctly when 
you hear them click into place.)

Print quality  ■ For best results, use KODAK Paper or a paper with the 
COLORLOK Technology logo on the package.

 ■ Make sure the paper is loaded correctly. See Loading paper, 
page 8.

 ■ Clean the printhead:
 – Press Menu.
 – Press  to select Maintenance, then press OK.
 – Press  to select Clean Printhead, then press OK.

 ■ Calibrate the printer:
 – Press Menu.
 – Press  to select Maintenance, then press OK.
 – Press  to select Calibrate Printer, then press OK.
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Troubleshooting

Problem Possible Solutions

Ink cartridge 
errors

 ■ Check that Ink Cartridge(s) are installed. Do not use refilled 
ink cartridges.

 ■ Remove, then install the cartridges again. Make sure the 
cartridges click into place.

Paper jam  ■ Open the printer access door and gently remove any paper 
from inside the printer.

 ■ Make sure the paper in the tray is free of tears or creases.
 ■ Make sure you do not overload the input paper tray.
 ■ If you cannot access the paper from the front, gently pull the 
jammed paper up from the paper input tray.

Error codes/
messages

Go to  
http://www.samsung.com/uk/support/download/
supportDownloadMain.do

http://www.samsung.com/uk/support/download/supportDownloadMain.do
http://www.samsung.com/uk/support/download/supportDownloadMain.do
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Troubleshooting

Power light
The power light (by the on/off button) indicates the condition of the printer.

Power light What it means

Off  ■ The printer is turned off.
 – Press the on/off button to turn on power.

 ■ The printer does not have power.
 – Make sure that the power cord is plugged into the

 ■ back of the printer and into an electrical outlet, and that the 
electrical outlet has power.

Blinking  ■ The printer is busy.
 – Wait for the printer to finish the task.

On  ■ The printer is ready.
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Product and Safety Specifications

Specifications and features

Print performance

ISO/IEC 24374 ESAT 7 ipm

ISO/IEC 24374 ESAT 4.6 ipm

Print technology Continuous-tone, thermal inkjet

Print quality modes Draft, Normal, and Best on plain paper Photo quality 
mode on photo paper

Photo printing features

Quantity 1 to 99

Print sizes 2 x 3 in. / 5 x 8 cm

3.5 x 5 in. / 9 x 13 cm

4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 30 cm (Panoramic)

The following specifications are subject to change without notice.

5
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Print sizes 5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter - 8.5 x 11 in. / 22 x 28 cm

A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Best, Normal, Draft modes on plain paper 
Photo quality mode on photo paper

Auto-detect media Auto-detect plain paper and photo papers Optimize 
image quality for KODAK Photo Papers with barcode

Image enhancement Image Enhancement Technology with Print Manager 
Software

Add date to prints No (default), Yes

Color Black-and-white or color

Scene balance On (default), Off

Copy document features

Color Black-and-white or color

Quantity 1 to 99 copies

Copy sizes Same Size, Fit-to-Page, 20% to 500%

Plain paper quality Best, Normal, Draft
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Brightness – 3 to + 3

Copy photo features

Color Black-and-white or color

Quantity 1 to 99 copies

Copy sizes 2 x 3 in. / 5 x 8 cm

3.5 x 5 in. / 9 x 13 cm

4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 30 cm (Panoramic)

5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter - 8.5 x 11 in. / 22 x 28 cm

A4 - 8.3 x 11.7 in. / 21 x 30 cm

Quality Automatic

Brightness – 3 to + 3
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Scanning features

Scanner type Contact Image Sensor (CIS)

Maximum scan size 8.5 x 11.7 in. / 22 x 30 cm

Functions Segmentation scanning

Auto-destination

OCR

Auto picture detection

Paper input tray features

Paper capacity 100 sheets of 20 lb plain paper

20 sheets of photo paper, up to 12 mil (290 gsm)

20 envelopes

Tray size 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm
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Ink cartridges

Ink life The number of pages may be affected by operating 
environment, printing interval, media type, and media size.

Based on ISO 24712 5% COVERAGE PATTERN  
- See A sample of 5% COVERAGE PATTERN (reduced to 
33%), page 78.

(supplied with the machine; INK-M210): About 250 sheets 
(supplied with the machine; INK-M215): About 430 sheets  
(supplied with the machine; INK-C210): About 250 sheets 
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A sample of 5% COVERAGE PATTERN (reduced to 33%)

{|}
Funtres Solber Netener

Stephen J. Singel
Fabanda Sinpat Abarress
Tendar, BSF
URANGLE

30 November 2005

Johnathan Q. Maderia

Inpert Mampem Abaress
2343 Stantin Dawer Lank
Benhibe, SDF

Mr. Maderia:

Nam liber tempor cum soluta nobis eleifend ption cogue nihil consequat, velillum.  Dolore eu zril feugiat 
nulla acilisis at vero eros accumsan et iust odio dignis sim qui blandit praesent lutatum ril lobortis nisl ut 
aliquip exea commodo consequat. Duis autem vel eum irure dolor in hendreritin ulputate velit esse 
molestie tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim vhniam, quis 
nostrud exerci tation ullam corpersus cipit tis nisl

Amet, Amet, consectetuer adipiscing elit, sud diam nonummy nibh veniam, 
ecneps adipiscing elit, sed diam nonummy nibtil laoreet dolore magmana aliam 
erat volutpat. Ut wisi enim minim veniam, quisient nostrud. Solyom uta nobis 
eleifendoptn cogue nihil imerdiet domg id quod mzim plerat facer posim aum. 
Lorem ipsm dolor sit amet, consectuer. Duis autem vel eum iriure dolor in 
hendreritin vulputate velit cesse ea commodo molestie.  Nam liber tempor cum 
soluta nobis eleifend option cogue nihil consequat, velillum. Dolore eu zril 
feugiat nulla facilisis at vero eros accumsan et iusto odio dignissim qui blandit 
praesent domg id quod mzim plerat facer posim aum.

Integer sagittis lacus vel nulla. Morbi convallis hendrerit risus. Nullam interdum, enim non gravida 
feugiat, quam ante consequat metus, sed molestie dolor tortor eu ipsum. Phasellus semper risus sit amet 
diam. Cras wisi arcu, pulvinar nec, molestie fringilla, vestibulum iaculis, mi. Praesent nonummy pulvinar odio.

Duis vitae eros. Fusce suscipit. Etiam justo massa, semper feugiat, porttitor sit amet, nonummy in, quam. 
Aenean nulla magna, elementum ut, eleifend ac, aliquam ut, risus. Morbi laoreet elementum dui. 
Vestibulum nibh sapien, rhoncus non, lobortis nec, ullamcorper a, enim. Praesent ultricies enim non 
lorem. Curabitur consectetuer, diam et nonummy convallis, quam quam tristique nulla, pulvinar blandit 
ipsum arcu a tellus. Phasellus dolor. Ut ullamcorper venenatis quam. Quisque egestas erat.

Singabet,

Stephen J. Singel
Demperta Aminerimum
Fabanda Sinpat Abarress

SJS:dwg

A B C D E

Stnecerp Balrecneps



79EN

Product and Safety Specifications

Connectivity

Protocols supported USB 2.0 High Speed; DPOF

Devices supported WINDOWS OS-based and MACINTOSH Computers, 
memory cards (SD, MS/Duo, MMC, SDHC)

Image Formats supported Image printing supports JPEG (EXIF v2.2); does not 
support progressive JPEG format

Number of USB ports One rear device port (high speed)

Protocols supported USB 2.0 High Speed (for connection to computer 
only), DPOF (Tagged image printing)

Software support

Application support Third-party image management applications; optical 
character reader (OCR) support for documents

Media support Plain paper, photo paper, envelopes, greeting cards, 
and labels

Scanner support TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), 
ICA (MAC OS), including segmentation scanning

Update support Software and firmware updates available through Web 
support
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Physical specifications

Power Input: 100–240 V AC, 50–60 Hz

The printer shall only be used with the provided 
certified external power supply. 

Manufacturer and model: 
Chicony Power Technology Co., Ltd, model 
A10-018N3A

Output: 36 V DC at 0.5 A

Dimensions 16.5. x 6.7. x 12.6 in. / 420 x 170 x 320 mm [L × H x D]

Weight 12.7 lb / 5.7 kg

Operating range 5°C (41°F) to 35°C (95°F), 15 to 85% RH

Full image quality environ-
mental range

15°C (59°F) to 30°C (86°F), and 20 to 80% RH.

Energy efficiency ENERGY STAR® Qualified All-in-One Printer
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System requirements

Computer with WINDOWS OS

Computer Minimum

Operating system WINDOWS 7, VISTA, or XP (SP2 or later)

CPU INTEL CELERON Processor

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 500 MB available

Interface USB 2.0 High Speed

Removable drive CD-ROM

Computer with MAC OS

Computer Minimum

Operating system MAC OS X 10.5 or later

CPU PowerPC G4, G5, or INTEL-based MAC

Clock speed 1.2 GHz

Memory 512 MB RAM

Available hard disk space 200 MB available
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Computer Minimum

Interface USB 2.0 High Speed

Removable drive CD-ROM

Paper types supported

Plain paper 16 to 24 lb (60 to 90 gsm)

Photo paper Up to 12 mil (290 gsm)

Card stock 110 lb index max (200 gsm)

Envelopes 20 to 24 lb (75 to 90 gsm)

Labels All commercially available inkjet varieties on 8.5 x 11 in. 
and A4 size sheets

Iron-on transfers All commercially available inkjet varieties on 8.5 x 11 in. 
and A4 size sheets
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Paper sizes supported

Plain paper A4 (8.3 x 11.7 in. / 21 x 30 cm)

A5 (5.8 x 8.3 in. / 15 x 21 cm.)

A6 (4.1 x 5.8 in. / 11 x 15 cm)

B5 (6.9 x 9.8 in. / 18 x 25 cm)

US Executive (7.3 x 10.5 in. / 18 x 27 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

US Legal (8.5 x 14 in. / 22 x 36 cm)

Custom sizes from 4 to 8.5 in. / 10 to 22 cm wide and

6 to 14 in. / 15 to 36 cm long

Labels A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)

Index card stock 4 x 6 in. / 10 x 15 cm cards

5 x 7 in. / 13 x 18 cm index cards

Iron-on transfers A4 (8.3 x 11.7 in. / 21 x 30 cm)

US Letter (8.5 x 11 in. / 22 x 28 cm)
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Envelopes C5 (6.7 x 9 in. / 16 x 23 cm)

C6 (4.5 x 6.4 in. / 11 x 16 cm)

DL (designated long) (11 x 22 cm / 4.3 x 8.7 in.)

US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)

US #9 (3.9 x 8.9 in. / 10 x 23 cm)

US #10 (4.1 x 9.5 in / 10.5 x 24 cm)

Photos 4 x 6 in. / 10 x 15 cm

4 x 7 in. / 10 x 18 cm

4 x 8 in. / 10 x 20 cm

4 x 12 in. / 10 x 31 cm

5 x 7 in. / 13 x 18 cm

8 x 10 in. / 20 x 25 cm

US Letter (8.5 x 11 in. / 22 x 28 cm)

A4 (8.3 x 11.7 in. / 21 x 30 cm)
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Safety Information

Safety Information
SAMSUNG CJX-1000 All-in-One Printers are Class 1 LED Products.

When using this machine, these basic safety precautions should always be followed to 
reduce risk of fire, electric shock, and injury to persons:

1 Read and understand all instructions.
2 Use common sense whenever operating electrical appliances.
3 Follow all warnings and instructions marked on the product and in the literature 

accompanying the product.
4 Use only the power source provided with the printer.
5 Use only the power cord that comes with the product (or an approved power cord 

greater or equal to H05W-F, 2G, 0.75mm2). Using another power cord may cause fire 
and/or shock. Do not use the included power cord with any other equipment.

6 If an operating instruction appears to conflict with safety information, heed the 
safety information. You may have misunderstood the operating instruction. If you 
cannot resolve the conflict, contact your sales or service representative for assistance.

7 Unplug the machine from the AC wall socket and telephone jack before cleaning. Do 
not use liquid or aerosol cleaners. Use only a damp cloth for cleaning.

8 Do not place the machine on an unstable cart, stand, or table. It may fall, causing 
serious damage.

6
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9 Your machine should never be placed on, near, or over a radiator, heater, air condi-
tioner, or ventilation duct.

10 Do not allow anything to rest on the power or telephone cords. Do not locate your 
machine where the cables may be damaged by people walking on them. Do not 
place the machine where the power or telephone cord may be bent. Any case of 
above may cause the hazardous result or malfunction.

11 Do not overload wall outlets and extension cords. This can diminish performance, and 
may result in the risk of fire or electric shock.

12 Do not allow pets to chew on the AC power, telephone, or PC interface cords.
13 Never push objects of any kind into the machine through case or cabinet openings. 

They may touch dangerous voltage points, creating a risk of fire or shock. Never spill 
liquid of any kind onto or into the machine.

14 To reduce the risk of electric shock, do not disassemble the machine. Take it to a 
qualified service technician when repair work is required. Opening or removing 
covers may expose you to dangerous voltages or other risks. Incorrect reassembly 
could cause electric shock when the unit is subsequently used.

15 Unplug the machine from the telephone jack, PC, and AC wall outlet, and refer 
servicing to qualified service personnel under the following conditions:
•	 When any part of the power cord, plug, or connecting cable is damaged or frayed.
•	 If liquid has been spilled into the product.
•	 If the product has been exposed to rain or water.
•	 If the product does not operate properly after instructions have been followed.
•	 If the product has been dropped, or the cabinet appears damaged.

•	 If the product exhibits a sudden and distinct change in performance
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16 Adjust only those controls covered by the operating instructions. Improper 
adjustment of other controls may result in damage, and may require extensive work 
by a qualified service technician to restore the product to normal operation.

17 Avoid using this fax machine during a lightning storm. There may be a remote risk of 
electric shock from lightning. If possible, unplug the AC power and telephone for the 
duration of the lightning storm.

18 Do not install the machine on a wet place. This may raise a risk of fire or shock.
19 CAUTION: For electrical safety reasons disconnect from telecommunications network 

before touching metal/conductive parts.
20 CAUTION: To reduce the risk of fire, use only No.26 AWG or larger telecommuni-

cation line cord.
21 CAUTION: Use only the cords and other accessories supplied with the product. Using 

others may cause the hazardous result or malfunction.
22 SAVE THESE INSTRUCTIONS.
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LCD Screen Safety
 ■ Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or chemical 

cleaners.
 ■ If the LCD screen is damaged, contact SAMSUNG immediately. If any of the solution 

from the display gets on your hands, wash them thoroughly with soap and water. If 
the liquid crystal solution gets into your eyes, flush your eyes immediately with water. 
If any discomfort or change in vision persists after washing, seek medical attention 
immediately.

Ink Cartridge Safety
 ■ Keep all ink cartridges out of the reach of children.
 ■ If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush 

your eyes immediately with water. If any discomfort or change in vision persists after 
washing, seek medical attention immediately.
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Declaration of Conformity (European countries)
Approvals and Certifications

The CE marking applied to this product symbolises Samsung Electronics Co., Ltd.  
Declaration of Conformity with the following applicable 93/68/EEC Directives of the 
European Union as of the dates indicated:

January 1, 1995:  Council Directive 73/23/EEC Approximation of the Member States 
related to low voltage equipment.

January 1, 1996:  Council Directive 89/336/EEC (92/31/EEC), approximation of the 
Member States related to electromagnetic compatibility.

March 9, 1999:  Council Directive 1999/5/EC on radio equipment and telecommunica-
tions terminal equipment and the mutual recognition of their conformity. 
A full declatation, defining the relevant Directives and referenced 
standards can be obtained from your Samsung Electronics Co., Ltd. 
representative.
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German compliance statement

 CAUTION:  
This device is not intended for use in the direct field of view at visual display 
workplaces. To avoid incommoding reflections at visual display workplaces this 
device must not be placed in the direct field of view.

 CAUTION:  
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschir-
marbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu 
vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert verden.

Noise emissions for this equipment do not exceed 70 dBa.

This equipment is not intended for use in the workplace in accordance with BildscharbV 
regulations.

“ Das GerŠt ist nicht fŸr die Benutzung am Bildschirmarbeitsplatz gemŠß BildscharbV 
vorgesehen.”



91EN

Safety Information

Correct Disposal of This Product  
(Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate collection 
systems)

                             This marking shown on the product or its literature, indicates that it 
should not be disposed with other household wastes at the end of its 
working life. To prevent possible harm to the environment or human 
health from uncontrolled waste disposal, please separate this from 
other types of wastes and recycle it responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of where and how 
they can take this item for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the 
purchase contract. This product should not be mixed with other commercial wastes for 
disposal.
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ENERGY STAR® Qualified
To conserve energy, this printer will enter a reduced power (sleep) mode automati-
cally after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. 
Increasing the delay time may result in reduced energy savings.

                              ENERGY STAR and the ENERGY STAR mark are registered U.S. service 
marks. As an ENERGY STAR partner, SAMSUNG has determined that this 
product meets ENERGY STAR Guidelines for energy efficiency. For more 
information on the ENERGY STAR program, see www.energystar.gov.

www.energystar.gov




www.samsung.com/printer


	SAMSUNG CJX-1000 All-in-One Printer
	Printer Overview
	Components
	Control panel
	Print Manager Software
	Configuring printer settings
	Paper
	Paper types
	Paper sizes
	Loading paper


	Basic Functions
	Printing
	Printing documents
	Printing pictures

	Copying
	Copying a document
	Copying a photograph

	Scanning
	Before you begin scanning
	Scanning from the computer
	Scanning from the control panel

	Ordering supplies

	Maintaining Your Printer
	General care and cleaning
	Cleaning the scanner glass and document backing

	Replacing ink cartridges
	Updating the software and printer firmware
	Updating if your printer is connected to a computer with WINDOWS OS
	Updating if your printer is connected to a computer with MAC OS

	Monitoring and adjusting printer performance
	Checking ink levels
	Resetting factory defaults

	Replacing the printhead

	Troubleshooting
	Basic troubleshooting
	Power light

	Product and Safety Specifications
	Specifications and features
	Print performance
	Photo printing features
	Copy document features
	Copy photo features
	Scanning features
	Paper input tray features
	Ink cartridges
	Connectivity
	Software support
	Physical specifications

	System requirements
	Computer with WINDOWS OS
	Computer with MAC OS
	Paper types supported
	Paper sizes supported


	Safety Information
	Safety Information
	LCD Screen Safety
	Ink Cartridge Safety

	Declaration of Conformity (European countries)
	Correct Disposal of This Product 
(Waste Electrical & Electronic Equipment)
	ENERGY STAR® Qualified


